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소개

First Rush는 macOS용 멀티 카메라 현장 레코더입니다. SDI 또는 지원되는 캡처 카드 입력을 편집 가
능한 동영상 파일로 기록하고, Scene / Cut / Take 메타데이터와 파일 이름 규칙을 녹화 흐름 안에서 바
로 관리할 수 있게 만든 앱입니다.

이 문서의 스크린샷은 실제 현장 영상이 아니라 mock source로 캡처했습니다. 캡처 환경의 UI 언어 때문
에 일부 화면 텍스트는 영문으로 보일 수 있지만, 기능 위치와 흐름은 동일합니다. 실제 카메라를 연결하면
프리뷰, 타임코드, 오디오, SDI 메타데이터가 장비와 신호 상태에 따라 표시됩니다.
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C H A P T E R  1

준비물

First Rush는 Apple Silicon Mac과 캡처 장비용 벤더 드라이버가 필요합니다.

지원 캡처 장비 계열:

Blackmagic Design DeckLink / UltraStudio 계열.

AJA 계열 장비.

현장 투입 전 권장 준비:

Blackmagic Desktop Video 또는 AJA Desktop Software를 먼저 설치합니다.

벤더 유틸리티에서 캡처 장비가 정상 인식되는지 확인합니다.

카메라 영상, embedded audio, timecode가 캡처 장비로 들어오는지 확인합니다.

ProRes 녹화가 가능한 충분한 저장 공간을 준비합니다.

첫 테이크 전에 짧은 테스트 녹화를 반드시 합니다.
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C H A P T E R  2

설치와 실행

1. 최신 First Rush DMG를 다운로드합니다.

2. DMG를 열고 First Rush를 Applications 폴더로 드래그합니다.

3. First Rush를 실행합니다.

4. macOS 권한 요청이 나오면 카메라 / 오디오 접근을 허용합니다. 이 권한은 Mac 내장 카메라가 아니라 캡처
카드 입력을 받기 위한 권한입니다.

First Rush는 Apple Notarized 빌드이므로 첫 실행 시 Gatekeeper 차단 없이 바로 열립니다. 만약 "확인되지 않
은 개발자" 경고가 뜨면 DMG가 중간에 손상된 것일 수 있으니 다시 받아 설치합니다.

라이선스와 7일 무료 체험

처음 실행하면 라이선스 시트가 뜹니다. 두 가지 선택지가 있습니다.

7일 무료 체험 시작: 라이선스 키 없이 7일간 정식 빌드의 모든 기능을 사용합니다. 체험이 시작되면 카운트다
운이 메뉴바와 라이선스 시트에 표시됩니다.

라이선스 키 입력: 구매 시 이메일로 전달된 키를 붙여넣고 활성화합니다. 키는 Mac 1대 단위로 묶이고 비활
성화 / 재활성화는 라이선스 시트에서 직접 처리합니다.

체험 기간이 끝나면 녹화 기능이 잠기고 시트가 다시 뜹니다. 그 상태에서도 캡처 신호 진단, FCPXML export,
Activity Log는 계속 쓸 수 있습니다.

라이선스 정보를 다시 보거나 다른 Mac으로 옮기려면 FirstRush > License...  메뉴를 사용합니다.

Sparkle 자동 업데이트

직접 배포 DMG 버전은 Sparkle 업데이트 프레임워크로 자동 업데이트를 받습니다.

첫 실행 후 잠시 뒤 EdDSA 서명된 appcast.xml 을 폴링합니다.

새 빌드가 있으면 알림 시트가 뜹니다. Install Update를 누르면 다운로드 → 무결성 검증 → 자동 설치 → 재
실행이 한 흐름으로 진행됩니다.

수동 확인은 FirstRush > Check for Updates... 에서 할 수 있습니다.

업데이트 채널이 끊긴 환경(현장 폐쇄망 등)에서는 무시해도 안전합니다 — 기존 빌드는 그대로 동작합니다.

업데이트가 실패하면 보통 디스크 권한, 격리 속성(quarantine), 네트워크 차단 중 하나입니다. FirstRush >

Check for Updates... 를 한 번 더 누르고, 안 되면 DMG를 다시 받아 수동 설치합니다.
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C H A P T E R  3

메인 화면 구조

메인 화면은 크게 다섯 구역으로 나뉩니다.

왼쪽 Source 사이드바: 카메라 / 캡처 입력 목록.

중앙 Viewer grid: 프리뷰, 녹화 상태, 타임코드, 오디오 미터, 소스 오버레이.

오른쪽 Inspector: 메타데이터, SDI 진단, 프리뷰 효과, LUT, 저장지 할당, 자동 녹화 설정.

하단 Slate strip: Scene / Cut / Take 입력과 슬레이트 모드.

하단 Gang control bar: 선택된 소스 또는 활성 소스의 녹화 / 정지 제어.

오른쪽 상단 툴바에서는 레이아웃, VU 미터, 타임코드 표시, 정보 오버레이, Slate strip, Activity Log, Inspector
를 켜고 끌 수 있습니다.

Layout 메뉴

상단 메뉴바의 Layout  또는 툴바의 레이아웃 버튼에서 Viewer grid 배치를 바꿀 수 있습니다.

Layout 메뉴

선택지:
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Auto Layout : 활성 소스 수에 따라 grid를 자동으로 맞춥니다.

1x1  / 2x2  / 3x3  / 4x4 : 고정 grid.

Primary + Right Strip : 주 화면 하나와 오른쪽 thumbnail strip 조합.

Primary + Bottom Strip : 주 화면 하나와 아래 thumbnail strip 조합.

Toggle Fullscreen : 현재 Viewer를 전체화면으로 전환.

소스 수가 자주 바뀌는 현장에서는 Auto Layout 이 편하고, 모니터링 우선 카메라가 정해져 있으면 Primary

+ Strip  계열이 시야 확보에 유리합니다.
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C H A P T E R  4

소스

왼쪽 사이드바의 Cameras  탭에서 캡처 소스를 확인합니다.

각 소스 행에서 볼 수 있는 정보:

하드웨어 백엔드: Blackmagic 또는 AJA.

소스 이름.

신호 / 실행 / 녹화 상태.

소스 활성화 스위치.

녹화하려면 먼저 소스를 켜야 합니다. No signal이 표시되면 카메라 출력 포맷, 케이블, 캡처 카드 입력 설정, 드라
이버 상태를 확인합니다.

Source Settings

소스를 선택하고 사이드바 하단의 gear 버튼을 누르거나, Viewer tile의 메타데이터 태그 버튼을 눌러 Source
Settings를 엽니다.

Source settings
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주요 설정:

Source name: UI에 표시되는 소스 이름.

Clip metadata: Scene, Take / Shot, Reel / Tape, Reel #, Camera make/model, Director, DP,
Production, Notes.

Video settings: 입력 포맷과 픽셀 포맷. 일반적으로 Auto-detect를 권장합니다.

Audio settings: 채널 수, 비트 depth, 오디오 delay, 채널 매핑, 오디오 라우팅, pre-record buffer.

Timecode source: SDI Embedded, Audio LTC, Mac Clock.

Auto-record trigger: 자동 녹화 시작/정지에 사용할 신호.

멀티-소스 다중 적용 (cmd-click)

여러 카메라를 한 번에 같은 설정으로 맞추고 싶을 때는 사이드바에서 소스를 Cmd-Click 으로 여러 개 선택합니
다. 선택된 소스는 헤더에 노란 강조 표시가 뜨고, 그 상태에서 변경한 Inspector / Source Settings 항목은 선택
된 모든 소스에 동시에 적용됩니다.

자주 쓰는 시나리오:

A / B / C 카메라에 동일한 destination 할당.

4대 카메라에 같은 codec preset / file name token을 한 번에 적용.

같은 camera label prefix(예: CAM_ )를 한 번에 부여.

동일한 auto-record trigger mode 일괄 설정.

다중 적용은 destructive 동작입니다. 선택된 소스의 기존 값은 새 값으로 덮어쓰여지므로, 특수 설정을 가진 소스가
섞여 있을 때는 Cmd-Click  선택을 풀고 개별 적용합니다.

크로스-소스 오디오 라우팅

Audio Source 는 기본적으로 해당 소스 자신의 SDI embedded audio를 사용하지만, 다른 소스의 오디오를
가져와 자신의 녹화 파일에 기록하도록 라우팅할 수도 있습니다. 현장에서 흔한 시나리오:

A 카메라에는 distant cam mic만 들어오고, B 카메라에 boom이 깔려 있을 때 → A 소스의 Audio

Source 를 B cam  으로 지정하면 A 녹화 파일에 boom이 함께 기록됩니다.

4대 카메라가 모두 같은 boom 채널을 공유해야 할 때 → Cmd-Click 으로 4대를 선택하고 동시에 한 소스
의 audio로 라우팅.

라우팅은 다음 클립부터 적용됩니다. 이미 녹화 중인 클립은 끝까지 자기 오디오로 마무리됩니다.
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Pre-record Buffer

Pre-record buffer 는 녹화 버튼을 누르기 직전의 N초를 메모리에 항상 잡아두는 기능입니다. REC을 누르
면 그 N초가 클립 앞에 함께 기록됩니다. 작가 / 감독이 "방금 좋았는데"라는 순간을 놓치지 않게 만드는 안전망입니
다.

권장 값: 3~5초 (메모리/CPU 부담 작음).

길게 설정할수록 RAM 사용량 증가.

자동 녹화(REC Flag)와 함께 쓰면 REC flag보다 살짝 앞 시점부터 클립이 시작됩니다.
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C H A P T E R  5

저장지

왼쪽 사이드바의 Records  탭에서 녹화 저장지를 설정합니다.

각 저장지는 다음을 정의합니다.

저장 폴더.

코덱 프리셋.

파일 이름 규칙.

비디오 설정.

오디오 트랙 구성.

타임코드 / 자막 기록.

녹화 후 처리 옵션.

저장지를 선택하고 gear 버튼을 누르면 Destination Settings가 열립니다.

Destination settings
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파일 이름 규칙

Token palette를 사용해 파일 이름을 만듭니다. 예:

S  + Scene  + _C  + Shot  + _T  + Take(auto)  + -  + CamLabel

결과 예:

S15_C02_T01-A.mov

Destination Settings의 Preview 줄에서 다음 녹화 파일 이름을 미리 확인할 수 있습니다.

코덱 프리셋

워크플로우에 맞춰 코덱을 선택합니다.

ProRes 422 Proxy: 현장 편집용 가벼운 프록시.

ProRes 422 / HQ 이상: 더 높은 품질의 편집 또는 후반 전달용.

H.264 / HEVC / DNxHR: 빌드와 destination 설정에서 활성화된 경우 사용.

현장 편집용이라면 별도 요구가 없는 한 ProRes 422 Proxy가 가장 안전한 기본값입니다.
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C H A P T E R  6

Slate Strip

하단 Slate strip은 여러 소스에 Scene / Cut / Take 값을 한 번에 적용하는 영역입니다.

지원 모드:

Film: 일반 영화식 Scene / Cut / Take.

Drama: Episode prefix가 있는 드라마 워크플로우.

Reel: 카메라 Reel / Clip name 중심 워크플로우.

Test: 테스트 클립용 별도 카운터.

Custom: 자유 형식 필드.

Auto +Take 를 켜면 녹화가 시작될 때마다 Take가 자동으로 증가합니다. 현재 값을 소스에 즉시 밀어 넣고 싶
을 때는 Apply 를 누릅니다.
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C H A P T E R  7

녹화

수동 녹화

하단 컨트롤 바를 사용합니다.

REC : 녹화 시작.

STOP : 녹화 정지.

Recording 메뉴의 Record All  / Stop All : 선택 또는 활성 소스 전체 제어.

단축키:

Command-R : Record All.

Command-K : Stop All.

Command-P : Pause All.

Shift-Command-P : Resume All.

Command-M : Chapter marker 삽입.

Chapter Marker

녹화 중 Command-M 을 누르면 현재 timecode 위치에 chapter marker가 찍힙니다.

Marker는 모든 활성 녹화 클립에 동시에 적용됩니다(갱 마커).

클립이 끝난 뒤 FCPXML로 export하면 marker가 함께 내보내져서 편집 앱에서 그대로 chapter로 보입니
다 (Final Cut Pro의 Chapter Marker, DaVinci Resolve의 Marker).

Marker에는 자동 라벨 ( Marker 01 , Marker 02 …)이 붙고, 필요하면 export 후 편집 앱에서 이름을
바꾸면 됩니다.

Activity Log에도 marker 이벤트가 기록되어 사후 확인이 가능합니다.

NG가 났을 때 빠르게 마커를 찍어두면 후반에서 NG 구간을 건너뛰기 쉽습니다.

자동 녹화

Inspector에서 소스별 Auto record를 켭니다. 자동 녹화를 쓰려면 해당 소스에 적어도 하나의 destination이 할당
되어 있어야 합니다.

First Rush는 두 가지 자동 녹화 트리거 모드를 지원합니다.
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REC Flag (SDI/HDMI) : 기본값이자 안정 경로입니다. DeckLink SDK record-trigger flag 또는
AJA RP188 record flag를 사용합니다.

HDMI TC Run (Beta) : DeckLink HDMI 입력용 보조 경로입니다. 타임코드가 움직이기 시작하면
REC, 멈추면 STBY로 판단합니다.

Auto-record trigger settings

SDI 카메라는 특별한 이유가 없으면 REC Flag (SDI/HDMI) 를 그대로 사용합니다.

Sony 미러리스 HDMI 워크플로우에서 HDMI TC Run (Beta) 를 테스트할 때는 카메라를 이렇게 맞춥니다.

HDMI Time Code Output: On.

REC Control: On.

TC Run: Rec Run.

Free Run timecode 상태에서 HDMI TC Run을 사용하면 타임코드가 계속 움직이므로 First Rush가 계속 녹화
상태로 판단할 수 있습니다.
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C H A P T E R  8

메타데이터와 Auto-Fill

First Rush는 녹화 파일에 clip metadata를 기록하고, 같은 값을 Inspector에서 바로 수정할 수 있게 합니다.

메타데이터 필드:

Scene.

Cut / Shot.

Take.

Reel / Tape.

Reel number.

Clip name.

Camera make/model.

Camera label.

Notes.

SDI camera info 영역은 VANC / ANC 패킷과 HUD OCR을 통해 카메라 정보를 읽습니다. 지원되는 신호에서는
Reel, Clip name, ISO, White Balance, Shutter, Lens 정보 등을 자동으로 채울 수 있습니다.

진단 칩 의미:

TC : 타임코드 감지.

REC : record flag 감지.

ANC : ancillary metadata 감지.

Audio : embedded audio 상태.

OCR : HUD OCR 상태.

Auto-fill이 동작하지 않을 때는 먼저 이 칩들을 봅니다. 보통 타임코드가 없는지, ANC가 없는지, 오디오가 없는지,
OCR이 실패하는지 바로 구분할 수 있습니다.

HUD OCR 자세히

ANC 패킷에 메타데이터가 실리지 않는 카메라(특히 미러리스, 일부 시네마 카메라의 HDMI 출력)는 화면 HUD를
직접 OCR로 읽어 메타데이터를 채웁니다. First Rush의 HUD OCR이 일반적으로 잘 읽는 정보:

Reel name (ARRI A001, A002 / RED R3D001 등 카메라 자동 채번 패턴).
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Clip name (카메라가 저장 중인 클립 파일명).

ISO / EI.

Shutter (셔터 속도 또는 셔터 각도).

White Balance / Tint.

Lens 정보 (Cooke /i, ARRI LDS 등 메타데이터 호환 렌즈).

동작 원리:

1. 1~2초 주기로 프리뷰 프레임의 HUD 영역을 캡처합니다.

2. ARRI / RED / Sony / Blackmagic 별 HUD 레이아웃 프리셋에 맞춰 ROI를 잡습니다.

3. Vision framework로 텍스트를 인식하고, 카메라 패턴에 맞춰 필드를 파싱합니다.

4. 성공한 값만 metadata에 자동 반영합니다( Auto-fill  토글이 켜진 경우).

OCR이 잘 동작하려면:

HUD가 프레임 안에 또렷이 보여야 합니다. 메인 모니터 보호를 위해 HUD를 끈 상태로 운용하면 OCR도 같
이 꺼집니다.

캡처 카드가 임의의 LUT을 입힌 신호를 받으면 텍스트 대비가 낮아져 인식률이 떨어질 수 있습니다.

다운컨버터를 거치면 HUD 폰트가 흐려져 OCR이 실패할 수 있습니다.

Help > Export SDI Diagnostic... 을 내보내면 OCR 시도 횟수 / 성공 횟수 / 마지막 실패 사례가 함께
포함됩니다. 인식률이 떨어진다면 이 진단을 첨부해 주세요.
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C H A P T E R  9

프리뷰 효과와 LUT

Inspector의 Preview / recording effects에서 프리뷰 보정과 가이드를 설정합니다.

주요 기능:

Auto crop.

Keep HUD metadata.

Grid.

Letterbox.

Rotation.

Flip H / Flip V.

Center Cross.

Preview LUT.

기본적으로 이 기능들은 프리뷰용입니다. 녹화 파일에 반영하고 싶을 때만 Apply to recording 을 켭니다.

현장에서는 안정성이 우선입니다. 현재 프리뷰가 안정적이면 렌더링 관련 설정은 촬영 중간에 바꾸지 않는 것을 권장
합니다.

종횡비와 Safe Frame

극장용 / OTT용 / 숏폼용으로 한 촬영 안에서도 출력 종횡비가 섞이는 경우가 많습니다. First Rush는 자주 쓰는 종
횡비를 한 번에 다룰 수 있게 해줍니다.

Letterbox / Pillarbox 가이드: 16:9 신호 위에 2.35:1, 2.39:1, 2:1, 4:3 등 자주 쓰는 종횡비 가이드를 표
시합니다. 가이드는 프리뷰에만 표시되어 액션을 프레이밍할 때 참조가 됩니다.

2.35:1 자동 스케일업: 1.78:1 또는 1.85:1 마스터 위에 시네마스코프(2.35:1) 컨테이너만 입혀서 모니터링
하고 싶을 때, 자동 스케일 + 가이드 표시를 한 번에 켭니다.

Safe Frame 자동 검출: 메타데이터 또는 HUD 정보로 카메라가 어떤 안전 프레임(예: ARRI Safe 90%,
RED Action Safe)을 쓰고 있는지 감지하고 그 가이드를 함께 띄웁니다. 카메라가 정보를 안 보낼 때는 수동
토글로 설정합니다.

9:16 세로모드 (숏폼 / Reels / Shorts)

릴스 / 쇼츠 / 틱톡 같은 9:16 워크플로우를 위해 별도 모드가 있습니다.
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1. Layout 메뉴 또는 Inspector에서 9:16 Portrait Mode 를 켭니다.

2. 16:9 신호 위에 9:16 crop frame이 표시됩니다.

3. 프레임 안쪽을 드래그해서 9:16 crop 영역을 좌우로 옮길 수 있습니다(인물 위치에 맞춰).

4. Apply to recording 을 켜면 9:16으로 잘린 영상이 그대로 녹화 파일에 기록됩니다. 꺼두면 원본
16:9는 보존되고 가이드만 표시됩니다.

세로모드는 Cycle Portrait Mode  단축키로 16:9 → 9:16(전체) → 9:16(좌) → 9:16(우)을 순환할 수도 있습
니다 (Layout 메뉴 참고).

3D LUT 프리뷰 (.cube)

LOG 신호로 들어오는 모니터링을 보기 쉽게 만들기 위해 3D LUT을 적용할 수 있습니다.

1. Inspector의 Preview LUT  영역에서 Pick LUT... 를 누릅니다.

2. .cube  파일을 선택합니다 (Rec.709 변환, 룩 LUT, 카메라별 공식 LUT 등).

3. 프리뷰에 즉시 반영됩니다. 강도 슬라이더로 적용 정도를 조절합니다.

4. 같은 LUT을 녹화 파일에도 굽고 싶다면 Apply to recording 을 켭니다.

권장 흐름:

모니터링은 LUT 적용 후 보기 쉬운 상태로 두고, 녹화는 LOG 원본 그대로 유지( Apply to recording

꺼둠)하는 게 일반적입니다.

현장 편집(on-set editorial)을 위해 LUT 굽힌 프록시가 필요하면 별도 destination을 만들고 그
destination만 Apply to recording 을 켭니다 — 그러면 원본 LOG 프록시 + LUT 굽힌 프록시 두
종류를 동시에 녹화할 수 있습니다.

지원되는 .cube 사이즈는 일반 17 / 33 / 65 cube까지 폭넓게 지원합니다.
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External Monitor

External Monitor  메뉴는 메인 화면과 별개로 외부 디스플레이(현장 모니터, OBS 캡처, 디렉터 모니터)에
풀스크린 영상을 보낼 때 사용합니다.

기본 흐름:

1. External Monitor > Open External Monitor... 를 선택합니다.

2. 연결된 디스플레이 목록에서 사용할 모니터를 고릅니다.

3. 표시할 소스를 선택합니다 (단일 소스 풀스크린 또는 Viewer grid 미러).

4. 종료할 때는 Close External Monitor  또는 모니터 위에서 Esc .

옵션:

Mirror Viewer Grid: 메인 창의 grid 그대로 외부 모니터에 그립니다. 모니터링 룸에 그대로 보낼 때 편합니
다.

Single Source Fullscreen: 한 소스만 풀스크린으로 출력합니다. 디렉터 모니터로 쓸 때 유용합니다.

Letterbox / Safe Frame: 외부 모니터에도 letterbox와 safe frame을 같이 표시할지 결정합니다.

Hide UI Overlays: REC 보더, 타임코드 오버레이 등을 외부 모니터에서만 끕니다. "깨끗한 화면"이 필요한
디렉터 모니터에 편합니다.

External Monitor는 모니터링 전용입니다. 외부 모니터에 보낸다고 별도 파일을 만들지 않습니다 — 녹화는 항상
메인 destination이 담당합니다.

성능 메모: 4K 60p를 외부 모니터에 풀스크린으로 보내면 Apple Silicon이라도 약간의 GPU 부담이 있습니다. 4
대 이상 동시 녹화 중에는 외부 모니터를 단일 소스 풀스크린으로 두는 게 안정적입니다.
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Activity Log와 진단

View > Activity Log 를 엽니다.

Activity and logs

Activity & Logs 창에서 볼 수 있는 것:

CPU, Memory, Disk free, Active recordings.

소스와 녹화 이벤트.

검색.

Clear.

Export.

SDI Diagnostic export.

신호 문제를 전달할 때는 Help 메뉴의 진단 기능을 사용합니다.

Help > Copy SDI Diagnostic

Help > Export SDI Diagnostic...

Help > Email SDI Diagnostic...



23

진단 export에는 앱 버전, 신호 포맷, timecode, record flag, audio channel, 최근 ANC packet 요약, OCR
attempt/success count, metadata source 상태가 포함됩니다.
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C H A P T E R  1 2

FCPXML Export

녹화 후 상단 FCPXML export 버튼을 사용하면 녹화된 클립과 메타데이터를 기반으로 편집용 프로젝트 구조를 내
보낼 수 있습니다.

Export 전 확인할 것:

Destination 폴더.

Scene / Cut / Take.

Camera label.

필요한 클립 녹화가 끝났는지.
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C H A P T E R  1 3

iPad Viewer

iPad Viewer 기능은 로컬 네트워크의 iPhone 또는 iPad로 모니터링 프리뷰를 보내는 기능입니다. Viewer는 모니
터링 전용이며 녹화 파일을 만들지 않습니다.

iPad Viewer > iPad Viewer... 를 엽니다.

Companion Viewer panel

Viewer 앱 설치

First Rush Viewer는 iPhone/iPad 전용 별도 앱입니다. App Store에서 검색해 설치합니다.

현재 앱 심사 중입니다. 심사가 완료되면 App Store에서 바로 다운로드할 수 있습니다. 심사 기간 동안에는 베
타 채널을 통해 배포될 수 있으며, 자세한 안내는 추후 공지로 전달됩니다.

기본 연결 순서

1. Mac에서 iPad Viewer 서버를 시작합니다.

2. Pairing code를 생성합니다.
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3. iPhone 또는 iPad에서 App Store에서 설치한 First Rush Viewer를 엽니다.

4. 같은 로컬 네트워크에서 페어링합니다.

5. Viewer가 볼 소스를 선택합니다.

보안 메모:

녹화는 항상 Mac의 First Rush가 담당합니다.

Viewer client는 모니터링 전용입니다.

Pairing code와 viewer event는 Companion Viewer panel에서 확인합니다.
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C H A P T E R  1 4

문제 해결

No Signal

확인할 것:

카메라 출력 포맷.

캡처 카드 입력 라우팅.

SDI 또는 HDMI 케이블.

벤더 유틸리티에서 장비 인식.

First Rush에서 source가 enabled 상태인지.

오디오가 안 들어올 때

확인할 것:

카메라 출력에 embedded audio가 있는지.

Source audio channel count와 bit depth.

Destination audio tracks.

Channel mapping.

Mute와 master monitor volume.

자동 녹화가 시작되지 않을 때

확인할 것:

해당 source의 Auto record가 켜져 있는지.

해당 source에 destination이 하나 이상 할당되어 있는지.

올바른 trigger mode를 선택했는지.

SDI 카메라: REC flag가 들어오는지.

Sony HDMI 카메라: HDMI TC output, REC Control, Rec Run timecode가 켜져 있는지.

Activity Log에 REC , STBY , cooldown, diagnostic 메시지가 찍히는지.
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메타데이터가 자동 입력되지 않을 때

확인할 것:

TC , ANC , OCR  진단 칩.

카메라의 해당 출력이 실제로 메타데이터를 보내는지.

컨버터, 무선 송수신기, 스위처가 ANC metadata를 제거하는지.

HUD가 OCR이 읽을 수 있을 만큼 보이는지.

Auto-fill이 켜져 있는지.

파일 이름이 예상과 다를 때

확인할 것:

Slate mode.

Scene / Cut / Take 값.

Destination file name token.

Camera label.

Auto +Take  상태.
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현장 체크리스트

첫 테이크 전:

캡처 장비 인식 완료.

필요한 소스가 모두 보임.

Signal, timecode, audio 확인.

Destination folder 설정.

Codec preset 확인.

File name preview 확인.

Scene / Cut / Take 설정.

자동 녹화를 쓴다면 trigger mode 확인.

짧은 테스트 녹화 후 편집 앱에서 열어보기.

Activity Log에서 새 이벤트를 보기 쉬운 상태로 정리.

촬영 중:

빨간 recording border와 REC timer 확인.

Disk free space 확인.

Auto +Take 동작 확인.

메타데이터가 중요하면 TC / REC / ANC / Audio / OCR 칩을 계속 확인.

세팅 변경 후:

Signal format 다시 확인.

Audio channel mapping 다시 확인.

Auto-record trigger mode 다시 확인.

짧은 테스트 녹화 다시 진행.



30

C H A P T E R  1 6

단축키

자주 쓰는 단축키를 한 곳에 모아둡니다.

녹화:

Command-R : Record All (활성 / 선택 소스 일괄 녹화 시작).

Command-K : Stop All.

Command-P : Pause All.

Shift-Command-P : Resume All.

Command-M : Chapter marker 삽입.

슬레이트와 메타데이터:

Command-Return : 현재 Slate 값을 선택 소스에 Apply.

Command-] : Take + 1.

Command-[ : Take − 1.

Shift-Command-] : Cut + 1.

Shift-Command-[ : Cut − 1.

선택과 다중 적용:

Cmd-Click : 사이드바에서 여러 소스 다중 선택 (다중 적용 활성화).

Shift-Click : 사이드바에서 범위 선택.

Cmd-A  (사이드바 포커스): 모든 소스 선택.

뷰:

Command-1  / Command-2  / Command-3  / Command-4 : Layout 1x1 / 2x2 / 3x3 / 4x4.

Control-Command-F : 현재 Viewer 풀스크린 토글.

Command-, : 환경설정 (있을 경우).

Command-Option-S : Slate strip 토글.

Command-Option-L : Activity Log 토글.

Command-Option-I : Inspector 토글.

iPad Viewer / 외부 출력:
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Command-Option-E : External Monitor 토글.

Command-Option-V : iPad Viewer 패널 토글.

라이선스 / 업데이트:

FirstRush > Check for Updates... : Sparkle 수동 확인.

FirstRush > License... : 라이선스 시트.

실제 단축키 일부는 빌드 또는 macOS 환경에 따라 다를 수 있습니다. 메뉴 항목 옆에 표시되는 단축키가 최종 기준
입니다.
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메뉴바 레퍼런스

상단 메뉴바의 주요 항목입니다.

FirstRush

About FirstRush : 버전 / 빌드 / 빌더 ( editor han ) 확인.

Check for Updates... : Sparkle 수동 업데이트.

License... : 라이선스 / 7일 체험 시트.

Preferences... : 일반 환경설정 (있을 경우).

Hide / Quit FirstRush : macOS 표준.

File

New Project : 새 작업 세션 시작 (Scene / Cut / Take 초기화 옵션 포함).

Open Recent : 최근 destination / project.

Export FCPXML... : 녹화 클립과 메타데이터를 FCPXML로 export.

Reveal Destinations in Finder : 활성 destination 폴더 열기.

Edit

macOS 표준 편집 메뉴 (Undo / Redo / Copy / Paste / Select All).

Slate 값 입력 필드에서 적용됩니다.

View

Show / Hide Inspector  ( Command-Option-I ).

Show / Hide Slate Strip  ( Command-Option-S ).

Show / Hide Activity Log  ( Command-Option-L ).

Show / Hide VU Meters .

Show / Hide Timecode Overlay .

Show / Hide Info Overlay .
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Recording

Record All  / Stop All  / Pause All  / Resume All .

Insert Chapter Marker .

Auto-record Trigger Mode  (소스별 자동 녹화 기본값 설정).

Layout

Auto Layout .

1x1  / 2x2  / 3x3  / 4x4 .

Primary + Right Strip  / Primary + Bottom Strip .

Toggle Fullscreen .

Cycle Portrait Mode  (16:9 ↔ 9:16 순환).

External Monitor

Open External Monitor... .

Close External Monitor .

Mirror Viewer Grid  / Single Source Fullscreen  토글.

Hide UI Overlays .

iPad Viewer

iPad Viewer... : Companion Viewer 패널 열기.

Start / Stop Server .

Issue Pairing Code .

Window

macOS 표준 윈도우 메뉴 (Minimize / Zoom / Bring All to Front).

Help

First Rush User Manual : 본 매뉴얼 PDF로 이동 (한국어 / 영문).

Copy SDI Diagnostic : 진단 정보 클립보드 복사.

Export SDI Diagnostic... : 진단 파일 저장.

Email SDI Diagnostic... : 진단 정보를 메일로 전송 (지원 문의).
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Open Activity Log .

메뉴 항목과 단축키는 빌드 / 환경에 따라 일부 다를 수 있습니다. 실제 화면의 메뉴를 우선합니다.


